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Chapter 8: MIDI Menu

MIDI Menu
How to get there
The MIDI Menu is one of Finale’s unchanging menus.

What it does
This menu contains items specific to your MIDI setup and usage.

• MIDI Setup. Choose this command to display the MIDI Setup dialog box, where you can 
make a number of settings concerning your MIDI interface setup. See MIDI SETUP DIALOG 
BOX.

• MIDI Thru. If you prefer to use one keyboard as a controller and another as the sound source, 
choose this command to specify your MIDI Thru preferences. MIDI Thru must be on if you 
wish to hear notes from one device as your entering them on another. See MIDI THRU DIALOG 
BOX.

• Import MIDI File Options. Choose this command to display the Import MIDI File Options 
dialog box.  This dialog box lets you set specific options for importing MIDI files.  You can 
also see this dialog box when importing a MIDI File. See IMPORT MIDI FILE OPTIONS DIA-

LOG BOX.
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• Export MIDI File Options. Choose this command to display the Export MIDI File Options 
dialog box.  This dialog box lets you set specific options for exporting MIDI files.  You can 
also see this dialog when exporting a MIDI File. See EXPORT MIDI FILE OPTIONS DIALOG 
BOX.

• Send MIDI Value. When you choose this command, the Send MIDI Value dialog box 
appears. Using the options in this dialog box, you can send any kind of MIDI data to your syn-
thesizers immediately: a patch change, a “pedal up” command, a “note off” command. See 
SEND MIDI VALUE DIALOG BOX.

• Send MIDI Sync. Choose this option when you want to Finale to transmit MIDI Sync (during 
playback) to an external “slave” device such as a drum machine or external sequencer. See 
MIDI SYNC for more information.

• MicNotator. Choose this command to display the MicNotator dialog box, where you can set 
up options for the MicNotator feature. With MicNotator, Finale converts the pitch you play in 
a microphone into a MIDI note when you use Speedy Entry or HyperScribe. If the 16-bit 
MIDI driver is selected, MicNotator will be unavailable because it requires the 32-bit driver. 
See MICNOTATOR DIALOG BOX.

• All Notes Off. From time to time, you may encounter MIDI lock, a rare situation in which a 
synthesizer sounds as if its keys are “stuck,” and it plays continuously as though someone’s 
still pressing them. To send the MIDI signal that tells it to “release the keys,” choose this com-
mand; after a moment, the synthesizer will be silent. Technically, this command sends a Note 
Off command to all notes on all channels.

• Start Playback • Stop Playback. These menu items provide keyboard access to the Playback 
Controls to start or stop the playback of a file.

• 16-bit MIDI Driver • 32-bit MIDI Driver. If your soundcard requires it, choose the 16-bit 
MIDI Driver. The 16-bit option will not appear on NT-derived systems. Most users should 
choose the 32-bit MIDI Driver. Please note, the MicNotator feature requires the 32-bit driver.
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MIDI Setup dialog box
How to get there
Choose MIDI Setup from the MIDI Menu.

What it does
In the MIDI Setup dialog box you can edit a number of settings pertaining to your MIDI interface 
setup.
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• MIDI In Device • MIDI Out Device. Use the MIDI In and MIDI Out settings to tell Finale 
which MIDI drivers you’d like to use. You can specify up to 8 slots (using one or more MIDI 
drivers) to receive and send MIDI information. You can specify different configurations for 
MIDI In and MIDI Out (see Advanced below). Under MIDI In, select the MIDI In device for 
your computer (for example, SoundBlaster MIDI Input). Under MIDI Out, select a device 
where you’d like to hear the music played back. By default, Finale will select “Default MIDI 
Out Device” on your computer. To use your computer’s speakers connected to your sound-
card, choose a driver with “Synth” or “Synthesizer” in it. To use an external MIDI device, 
choose a driver with “MIDI Out” or “MPU 401” in its name.

•  Advanced. Click the Advanced button to expand the dialog box for more than one device.

• Base Channel. You can specify the initial MIDI channel number for each MIDI driver 
selected. This number indicates the first of 16 channels. Finale supports 64 MIDI channels 
through different MIDI drivers.

• Sync Master. Click in this column if you want Finale to transmit MIDI Sync signals any time 
it plays back your score through the corresponding MIDI driver and MIDI channels (specified 
by the Base Channel for that driver). Only one device at a time can send MIDI Sync signals. If 
you have connected your computer to an external sequencer, drum machine, or another com-
puter that has been configured to interpret this kind of MIDI message, it will wait in “pause” 
mode until Finale begins playback, at which point the two will play together in perfect syn-
chronization.

• Reset MIDI Out. This option sends a “Key off” message to all notes, on all channels when 
the port is made inactive. This check box should only be unchecked (disabled) if your MIDI 
device(s) are responding with a “MIDI Buffer Overflow” or “MIDI Communication Error” 
when receiving such a command.

• OK • Cancel. Click OK to confirm, or Cancel to discard, the changes you’ve made to the 
MIDI settings in this dialog box and return to the score.

MIDI Thru dialog box
How to get there
Choose MIDI Thru from the MIDI Menu. The MIDI Thru dialog box appears.

What it does
MIDI Thru is the MIDI configuration whereby you play the keys on a controller keyboard, the 
MIDI signal travels to your computer, and the computer in turn sends the signal to a second MIDI 
keyboard—the one that actually produces the sound. If you have such a setup, you must turn on 
MIDI Thru to tell Finale to pass incoming MIDI signals along to the next MIDI keyboard.

Use the MIDI Thru dialog box to choose how you want MIDI Thru to work when you use Finale. 
The choices are to turn MIDI Thru off, map all channels to a single fixed channel, use Smart MIDI 
Thru (for recording with HyperScribe or editing with Speedy Entry), map each channel directly to 
the channel that is being played, or use an editable table of channels where you explicitly map 
each incoming channel to the outgoing channel you specify.
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• Off. Click this option if you don’t want to use MIDI Thru at all. When selected, no routing 
takes place.

• Fixed Channel. Click this option if you want to route all incoming channels to the single 
channel you specify. Enter the number of the channel that you want all channels mapped to.

• Smart. Click this option if you want to hear the channel and patch assigned to a staff while 
you’re recording with HyperScribe or editing with Speedy Entry. When selected, Finale looks 
at the Instrument List to see what instrument sound is set for the staff, and routes all incoming 
signals to the channel defined for that instrument. Note, however, that if you’re just playing 
your MIDI keyboard and not recording with HyperScribe or editing with Speedy Entry, Finale 
continues to use the last active “smart” channel (i.e., the last edited staff’s channel).

• Direct. Click this option if you want Finale to map the outgoing channels directly to the 
incoming channels that are being played. (This is the same as choosing Table and leaving the 
MIDI Thru Table at its default mapping, in which the outgoing channel is the same as the 
incoming channel.)

• Table • Edit. Click this option if you want to map incoming channels to different outgoing 
channels on a channel-by-channel basis. Click Edit to display the MIDI THRU TABLE DIALOG 
BOX where you can remap each incoming channel by entering a channel number in each text 
box.

• OK • Cancel. Click OK (or press enter) to confirm the MIDI Thru setting, or click Cancel to 
discard any changes you’ve made to the dialog box and return to the score. If you selected a 
MIDI Thru mode, MIDI Thru will be checked in the MIDI Menu. If you selected Off, MIDI 
Thru will not be checked, indicating that no MIDI Thru mode is in use.
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MIDI Thru Table dialog box
How to get there
Choose MIDI Thru from the MIDI Menu. Click Table, then click Edit.

What it does
Midi Thru is the MIDI configuration whereby you play the keys on a controller keyboard, the 
MIDI signal travels to your computer, and the computer in turn sends the signal to another MIDI 
keyboard—the one that actually produces the sound. In this dialog box, you can route the signals 
coming from your controller keyboard to other MIDI channels, giving you control over which 
channels are received by your sound module.

• 1—64. The fixed number on the left indicates the channel of the incoming MIDI signal. Enter 
into the text box the number of the desired output channel for producing the sound. The 
default setting for each input and output channel is one-to-one.

• Reset. Click this button to restore all settings to the original one-to-one channel mapping.

• OK • Cancel. Click OK (or press enter) to confirm the MIDI Thru Table settings, or click 
Cancel to discard any changes you’ve made to the dialog box and return to the MIDI Thru dia-
log box.
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Import MIDI File Options dialog box
How to get there
Choose Import MIDI File Options from the MIDI Menu. The Import MIDI File Options dialog 
box appears.

Or,

Choose Open from the File Menu and click MIDI File (from the File Type drop-down list). Dou-
ble-click the name of the MIDI file you want to transcribe.

What it does
When you tell Finale to “open” a MIDI file, you’re essentially telling it to transcribe the file. The 
options in this dialog box are very similar to those you encounter when you’re transcribing real-
time performances in a Finale document—quantization and split point options, key and time sig-
nature settings, and commands to “capture” MIDI data (such as pedaling and key velocity infor-
mation).

You also use this dialog box to tell Finale how you want the tracks of the sequencer file translated 
into Finale staves. For example, you can specify that each track simply become one staff, or that 
the contents of each MIDI channel become one staff. However, you can also enter other dialog 
boxes from within this one, where you can specify much more elaborate track-to-staff configura-
tions.

Follow your sequencer’s instructions for creating a standard MIDI file.
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• Tracks Become Staves. Click this button if you want Finale simply to notate the contents of 
each sequencer track on one staff. Finale will select the treble or bass clef for each staff, based 
on the register of the music in each track. In fact, if the notes have such a wide range that it 
wouldn’t be appropriate to place them all on one staff, Finale splits the track into two staves 
with different clefs.

Technical note: Finale selects a clef as follows. If all the notes of the track are above MIDI key 
number 47 (that’s B a ninth below middle C), it selects the treble clef. If all notes are below 
key 72 (C above middle C), it selects the bass clef. If the notes in the track don’t fall into either 
category, Finale transcribes them onto two staves, splitting them into treble- and bass-clef 
staves using F below middle C as a split point.
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• Channels Become Staves. Click this button if you want the contents of each MIDI channel 
(regardless of its track assignments) transcribed onto a single Finale staff. Once again, Finale 
attempts to make intelligent decisions regarding the selection of a clef for each staff.

• Set Track-to-Staff List; Select. If you click this button, Finale will display the Track/Channel 
Mapping for Staves dialog box when you open a MIDI file, where you can specify a number 
of track, MIDI channel, and staff configurations. You can specify the top-to-bottom order of 
the resulting Finale staves, as well as staff transpositions, clefs, and the distance between 
staves in the resultant Finale document. The Select button is only displayed when you are 
importing a file and do not have Don’t show this during File Open selected. If you have 
selected Set Track-to-Staff List and Don’t show this during File Open while in the MIDI 
Menu, the Track/Channel Mapping to Staves dialog box will appear when you open a MIDI 
file instead of the Import MIDI File Options dialog box. See TRACK/CHANNEL MAPPING TO 
STAVES DIALOG BOX for full details.

• Key Signature: Use the File’s. Click this button if you want Finale to notate the transcription 
with the key signature specified by the MIDI file (if it was created by a sequencer that lets you 
specify one).

• Key Signature: Infer from the File. Click this button if you want Finale to attempt to deduce 
the correct key signature by examining the notes in the sequencer file. Finale will analyze the 
music, measure by measure, placing key changes where it considers them necessary. You 
won’t see the results of Finale’s intelligent guesses until it’s finished transcribing the file into 
standard notation.

• Key Signature: Infer, ask me first. Click this button if you want Finale to attempt to deduce 
the correct key signature by examining the notes in the sequencer file, but to let you confirm 
its guesses. When you click the OK button to begin the transcription, Finale will display the 
key signature dialog box at each measure in which it detects a key change, letting you confirm 
or cancel its decision.

• Key Signature: Set Key Signature. Click this button if you simply want to tell Finale what 
key the file is in. Finale displays the Key Signature dialog box, where you can scroll to the 
correct key signature and click OK.

• Time Signature: Use the File’s. Click this button if you want Finale to notate the transcrip-
tion with the time signature specified by the MIDI file (if it was created by a sequencer that 
lets you specify one).

• Time Signature: Set the Time Signature. Click this button if you simply want to tell Finale 
what time signature the file is in. Finale displays the Time Signature dialog box, where you 
can set the correct time signature and click OK. (See TIME SIGNATURE DIALOG BOX if you 
need help in setting the time signature.)
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• Tempo Changes • Continuous Data • Convert Markers. These options tell Finale to 
remember the precise “feel” of the original sequence, and to keep this data handy for playback 
once it’s been transcribed. (These are the same as Save Tempo Changes, and Save Continuous 
Data checkboxes in the Transcription window.) If you don’t choose these options, then when 
you play back the transcribed music from the score, Finale will simply play the “sheet 
music”—the notated version, which will be rhythmically precise but expressionless and 
“square”—instead of an exact re-creation of the original sequence. (Important note: To play 
back your music with these captured nuances, be sure you’ve selected all four data types for 
playback (see PLAYBACK OPTIONS DIALOG BOX).

Tempo Changes information describes changes in the actual tempo, such as ritards and acce-
lerandi.

Continuous Data is controller data (MIDI signals generated by pedals, patch changes, and so 
on) and wheels (like the pitch wheel).

Convert Markers defaults to on. Click it if you do not want the sequencer markers converted 
to Finale bookmarks

• Create Instruments from Initial Patches • Use General MIDI Patch Names. Use these set-
tings to import patch information into Finale’s instrument list.

• Quant Settings. Click this button to display the Quantization Settings dialog box where you 
can set more options regarding the type of quantization, smallest allowed value, whether to 
capture Key Velocities and Note Duration, etc. See QUANTIZATION SETTINGS DIALOG BOX.

• Create Percussion Staves: Channel • Clef • Percussion Map. Check this box to have Finale 
create and configure percussion staves from the MIDI file. Enter the playback channel in the 
Channel text box. Finale will suggest channel 10, the default percussion channel for General 
MIDI. Next to Clef, Finale will display the selected clef for percussion staves. Click Select to 
choose a different clef. The Percussion Map text box indicates which Percussion Map will be 
used to adjust the display of percussion noteheads, placement and alternate playback. Click 
the Select button to choose a different percussion map. See PERCUSSION.

• Don’t show this during File Open. Select this option if you wish to use the current settings in 
the Import MIDI File options next time you import a MIDI file. The Import MIDI File Options 
dialog box will not be displayed when you import a MIDI file, only when Import MIDI File 
Options is selected from the MIDI Menu. Deselect this checkbox to again display the Import 
MIDI File Options dialog box when importing MIDI files. If you have selected Set Track-to-
Staff List and Don’t show this during File Open, Finale will display the Track/Channel Map-
ping to Staves dialog box without first going through the Import MIDI File Options dialog 
box. See TRACK/CHANNEL MAPPING TO STAVES DIALOG BOX.

• OK • Cancel. Click OK (or press enter) to proceed with the transcription. After a moment, 
Finale displays the transcribed score. If you discover that your settings weren’t quite right, 
you can close the new Finale document and try again—the original MIDI file is unaffected by 
Finale’s transcription efforts. Click Cancel if you decide not to transcribe the MIDI file.
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Track/Channel Mapping to Staves dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. If you have already selected Set Track-to-Staff 
List and Don’t show this during File Open, Finale will display the Track/Channel Mapping to 
Staves dialog box without first going through the Import MIDI File Options dialog box.

What it does
The easiest way to translate the “tracks” from your MIDI sequencer file into notated Finale staves 
is to leave the default option, Tracks Become Staves, selected. When you do, each track from your 
sequencer file is transcribed onto its own staff in Finale.

If you want more flexibility, however, you can display this dialog box, in which you can specify a 
number of track, MIDI channel, and staff configurations. You can specify the top-to-bottom order 
of the resulting Finale staves, as well as staff transpositions, clefs, and the distance between staves 
in the resultant Finale document.

• AutoSet to Tracks • AutoSet to Channels. Click these buttons to create a Finale staff for each 
sequencer track or MIDI channel, respectively. You’ll notice that these are exactly the same as 
the Tracks Become Staves and Channels Become Staves options in the previous (Import MIDI 
File Options) dialog box. The difference is that after clicking one of these buttons, you can 
then modify the assignments that appear in this dialog box. For example, you can set the 
staves’ clefs, transpositions, names, and so on—options that aren’t available when you click 
the Tracks Become Staves or Channels Become Staves buttons.
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• Track/Channel • Split • Name • Trans • Clef • Distance • Perc. The largest part of this dialog 
box is devoted to this display, which is a scrolling list of the 128 possible staves you can create 
in any Finale document. In the Track/Channel column, you see the name of each track and the 
MIDI channel to which it was assigned in the original sequencer file. In the Split column, 
Finale displays the split option, if you’ve specified one (for example, you might want the track 
split into two staves—for a piano part, for example). The Name column displays the staff 
name; Trans is the transposition, if any (for a transposing instrument such as a trumpet or clar-
inet); Clef indicates the clef, by number (0 through 15); and Distance indicates the distance 
between the top line of the staff and the top line of the one above it.The Perc column indicates 
which Percussion Map will be used to adjust the display of percussion noteheads, placement 
and alternate playback.

Each row of information represents one Finale staff. To specify all of the variables mentioned 
above, click anywhere in a row (but define the rows from top to bottom). The Track/Channel 
Mapping dialog box appears, where you can split the sequencer track you clicked into as 
many as eight Finale staves. You can base this split on MIDI channel, the range of notes (like 
the Split Point and Hand Width options in the Transcription Mode), or the top-to-bottom order 
of notes in each chord (like the Explode Music command in the Mass Mover Menu). 

See TRACK/CHANNEL MAPPING DIALOG BOX for more information.

• Load • Save. Once you’ve created a mapping setup, you needn’t re-create it the next time you 
want to transcribe a similarly configured MIDI file. Instead, after creating the mapping by 
working through this dialog box, click Save; Finale asks you to title this “TrackMap file.”

Later, if you want to transcribe the same MIDI file—or a similarly configured one—click 
Load. Double-click the TrackMap File’s title in the list box that appears; the Track/Channel 
Mapping dialog box fills itself out automatically.

• Set Dist. Click this button to display the Set Distances dialog box, in which you can specify a 
uniform distance between staves in the resultant Finale document, as well as the distance 
between the top staff and the top page margin. See SET DISTANCES DIALOG BOX for details.

• Sweep. This button lets you find out which MIDI channels were assigned to a given track. 
Click the button; the Sweep For Channels Present In A Track dialog box appears. In the text 
box, enter the number of the track you want scanned, then click Sweep. In the display, Finale 
places an X below each MIDI channel number on which you recorded data in this track. 
Finale displays this information for each of four data types; see SWEEP FOR CHANNELS DIA-

LOG BOX.

• OK • Cancel. Click OK (or press enter) to confirm your track-to-staff mapping and return to 
the Import MIDI File Options dialog box. Click Cancel to return to the Transcribe MIDI 
Channel dialog box without changing the track-to-staff mapping.
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Set Distances dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. Define track-to-staff mappings for the desired 
tracks by clicking each row of information (see TRACK/CHANNEL MAPPING DIALOG BOX). When 
you’re finished, click Set Dist.

What it does
In this dialog box, you can specify a uniform distance between staves in the Finale document that 
results from your MIDI file transcription, as well as the distance between the top staff and the top 
page margin. Note that you can override these settings on a staff-by-staff basis by clicking the 
staff name and changing the Distance number in the Track/Channel Mapping dialog box.

 

• Distance to Top Staff. The number in this text box specifies the distance between the top line 
of the first staff and the top of the window in Scroll View (the default is –.28 inches, because 
it’s being measured down from the top of the window). You can think of this distance as the 
distance between systems.

• Distance Between Staves. The number in this text box specifies the distance from the top line 
of one staff to the top line of the next. The default is –.83 inches, because each successive staff 
is placed below the previous one in the system.

• OK • Cancel. Click OK (or press enter) to confirm your staff placement settings and return to 
the Track/Channel Mapping to Staves dialog box. Your distance settings will be reflected in 
the Distances column. Click Cancel to return to the Track/Channel Mapping to Staves dialog 
box without specifying a uniform distance between staves and systems.

Sweep For Channels dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want to transcribe. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. Click Sweep.
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What it does
This dialog box is a reference feature; it helps you identify the tracks of the sequencer file you’re 
transcribing by showing you which MIDI channels contain recorded data.

 

• Sweep Track. Enter the number of the sequencer track you want to scan for information in 
this text box.

• KeyOn/KeyOff. When you click Sweep, Finale places an X in this row for each MIDI chan-
nel in which you recorded notes (Finale searches for “note on” and “note off” data).

• Controller • Patch Change • Pitch Wheel. When you click Sweep, Finale places an X in 
these rows for each MIDI channel in which you recorded MIDI controller (pedaling, for 
example), patch change, and pitch wheel information, respectively. 

• Sweep. Click this button to tell Finale to display an X in the column for each MIDI channel 
number in which one of the four data types was recorded on the specified track. This process 
has no effect on your data; it’s strictly an indicator to help you identify the track you’re work-
ing with.

• Done. Click this button to return to the Track/Channel Mapping to Staves dialog box.

Track/Channel Mapping dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. In the Track/Channel Mapping for Staves dia-
log box, click the topmost unassigned row of track information.
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What it does
This dialog box offers you a great deal of control over the way in which your sequencer-file tracks 
are transformed into Finale staves.

For example, you can tell Finale to create up to eight staves out of a single sequencer track. You 
can also tell Finale to create one Finale staff from up to four sequencer tracks—to transcribe sev-
eral woodwind tracks onto a single staff, for example.

Furthermore, you can create four staves from four tracks, but without necessarily having a track-
to-staff correspondence; for example, you can tell Finale to treat the notes in all four tracks as if 
they came from a single track, and then to split them into Finale staves by register—the highest 
notes into one staff, and so on.

This dialog box also lets you specify the staff name, clef, transposition, and spacing of each 
resultant Finale staff.You can also select a Percussion Map which adjusts the percussion notehead, 
placement and alternate playback.

 

• Track/Channel Mapping for Slot (#). This number indicates which “slot” or row of track 
information you’re creating or editing.
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• Track/Channel. There are four pairs of text boxes at the top of the screen, letting you specify 
the track number (and, within that track, the MIDI channel number) of each sequencer track 
whose music you want included in the staves you’re about to create.

To create a single staff from a single track, enter the track’s number and the MIDI channel 
from which it was recorded in one pair of the Track/Channel boxes. Note: You normally don’t 
have to enter anything in the MIDI Channel text box (the second text box of each pair). Enter 
a MIDI channel value only if you want to specify that a single MIDI channel’s data be tran-
scribed from a track containing music recorded from several MIDI channels.

Next, enter a staff name, transposition, clef, and so on. Of the Split options, leave None 
selected—otherwise, you’ll transcribe the selected track onto more than one staff.

To create a single staff from multiple sequencer tracks, enter up to four track/MIDI channel 
number pairings in the text boxes. (Note again that you can leave the MIDI Channel boxes 
blank—or enter zero—if each track was only recorded from a single channel, or if it’s OK for 
Finale to notate the contents of all channels in the track onto one Finale staff.) Once again, 
enter a staff name, and leave the None radio button selected—or, if you want to include on the 
resultant staff only the notes within certain pitch ranges, click Filter (see below).

To create several staves from either a single sequencer track or several tracks, enter the track 
and channel numbers in the text boxes, as before. This time, however, you must specify one of 
the Split options (see below). As far as Finale is concerned, the music on all the tracks you’ve 
specified in the text boxes are part of a single “source” track, which you can then split, by reg-
ister, into as many as eight staves.

• Split: None. If this radio button is selected, Finale will place the music from all the tracks 
you’ve specified in a single staff, instead of splitting it into separate staves.

• Fixed. When you click this radio button, Finale displays a special Split Point dialog box, in 
which you can specify up to four split points for the music in the specified tracks. In each pair 
of text boxes, you enter a low and a high key number; in this way, you can specify up to four 
registers, each of which will be notated on its own staff (in the same top-to-bottom order as the 
text box pairs) in the resultant Finale document. (Middle C is key number 60, and the numbers 
increase sequentially as you move up the keyboard. But you don’t have to type in these num-
bers; you can enter them simply by clicking the Listen button and then playing the notes. 
Finale will enter their key numbers in the text boxes automatically. See FIXED SPLIT DIALOG 
BOX for a more complete discussion.)

• Multiple. Click this button to display the Multiple Splits dialog box, where you can “explode” 
all the music on the specified tracks onto as many as eight staves. The advantage of this 
method is that notes are “separated out” in order from top to bottom, instead of by register; in 
other words, this would be a more appropriate way to separate single musical lines—for string 
parts, for example—into individual staves.

This dialog box works in much the same way as the Explode Music command in the Mass 
Mover Menu, letting you specify the number of resultant staves as well as the Overload Order. 
For a more complete discussion, see MULTIPLE SPLITS DIALOG BOX.
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• Hand Width. Click this radio button to display the Hand Width Split dialog box, which lets 
you transcribe the contents of the sequencer tracks you’ve specified onto two staves, splitting 
the notes by tracking the positions of your hands on the keyboard. Finale follows your hands 
as they move up and down the keyboard, eliminating the need to specify a single, fixed split 
point—provided there’s always enough distance between the hands for Finale to tell which 
hand is which. For a more detailed discussion of this dialog box, see HAND WIDTH SPLIT DIA-

LOG BOX.

• Filter. Click this radio button to display the Filter Channels dialog box. With this option, you 
can specify certain ranges of notes from each of several tracks that you want to be merged 
onto a single Finale staff. See FILTER CHANNELS DIALOG BOX for more information.

• Staff Names. In these text boxes, enter staff names for the Finale staves you’re creating.

• Transpose. Click the appropriate Transpose checkbox to display the Staff Transpositions dia-
log box, in which you can specify an instrumental transposition (for a trumpet or clarinet, for 
example). This is the same dialog box that appears when you click Transposition in the Staff 
Attributes dialog box; see STAFF TRANSPOSITIONS DIALOG BOX for a complete description of 
the options.

• Clef • Select. This text box identifies, by number, the staff’s starting clef. Finale offers sixteen 
standard clefs, numbered 0 through 15; for a table of these clefs, see CLEFS.

Enter the number in each Clef text box corresponding to the clef you want to designate as the 
starting clef for the resultant Finale staff. You can also click Select to choose from a graphic of 
each available clef.

• Distance. The number in this text box specifies the distance, between the top line of the staff 
you’re defining and the top of the Finale window (in Scroll View). It’s a negative number, 
because this staff appears below the top of the window. Note that if you want all your staves 
evenly spaced, you don’t have to enter numbers in these boxes; instead, when you return to the 
Track/Channel Mapping to Staves dialog box, click Set Dist. A dialog box appears, in which 
you can enter a global staff distance measurement. (See SET DISTANCES DIALOG BOX.)

• Percussion Map • Select. The number in this text box specifies which Percussion Map you’ve 
selected for this staff. Click the Select button to open the Percussion Map Selection dialog 
box, where you can select from any Percussion Maps available in the default file. See PERCUS-

SION.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the track-to-staff 
configurations you’ve created. You return to the Track/Channel Mapping to Staves dialog box.
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Fixed Split dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-To-Staff List radio button. In the Track/Channel Mapping to Staves dia-
log box, click the top unassigned row of track/channel mapping information. In the text boxes at 
the top of the Track/Channel Mapping dialog box, enter the track numbers and MIDI channel 
numbers of the “tracks” you want to split. Click Fixed.

What it does
In this dialog box, you can specify up to four split points for the music in the sequencer track (or 
tracks) you’ve specified for transcription. In each pair of text boxes, you specify a range of notes 
you want to appear in a separate staff. You could, for example, include only the notes in the flute’s 
register to place in one staff; only the notes in the bass’s register to put in another, and so on. You 
can even specify overlapping split ranges so that some notes are transcribed more than once.

 

• Key Range: Low • High. In each pair of Low/High text boxes, enter a low and a high key 
number, where middle C is key number 60, and the numbers increase sequentially as you 
move from left to right on the keyboard. The notes to which these synthesizer key numbers 
refer—and all notes in between—will be split into their own staff.

Note that you don’t have to calculate the key numbers and type them in manually. Click the 
Listen button (see below) beside each pair of text boxes, and play each note—the lowest, then 
the highest note in the range; Finale enters their key numbers in the text boxes automatically.
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You can split the notes of the track (or tracks) you’ve indicated into as many as four separate 
staves this way. These staves will appear in the same top-to-bottom order as these pairs of text 
boxes.

• Listen. When you click this button, Finale goes into “listen” mode, waiting for a MIDI signal. 
(A message to this effect appears on the screen.) Simply play the desired key on your key-
board; Finale enters the appropriate key number in the active text boxes.

• Split into __ Staves. After indicating all the desired ranges of notes in the text boxes (see 
above), tell Finale how many resultant staves you want by entering the appropriate number in 
the Split text box (1 to 4).

• OK • Cancel. Click OK (or press enter) to confirm your split points, or Cancel to discard them, and 
return to the Track/Channel Mapping dialog box. In the Split column for the row you clicked, you’ll 
see Fixed (if you clicked OK) or None (if you clicked Cancel).

Multiple Splits dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. In the Track/Channel Mapping for Staves dia-
log box, click the top unassigned row of track information. Click Multiple.

What it does
This dialog box works much the same as the Explode Music dialog box in the Finale program 
itself, but you use it when you’re transcribing a standard MIDI sequencer file. In essence, it lets 
you strip a chordal passage (from the combined sequencer tracks you’ve specified) into individual 
single-line melodies on separate staves. This is a good technique for separating single musical 
lines—for string parts, for example—into individual staves.

Before it will “explode” the specified tracks, however, Finale needs you to tell it, in this dialog 
box, how many resultant staves you want and how Finale should handle cases where there are 
more notes in a chord than there are staves to put them on.

 

• Split into __ Staves. In this text box, enter the number of staves you want to result from this 
separation process. Finale takes the top note on each beat and places it in the top new staff; the 
second note on the second staff, and so on.
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• Overload Order. The Overload Order is the order in which “extra” notes are assigned to the 
resultant staves. For example, if you’re splitting the music from a chordal sequencer track into 
three staves, and one of the chords contains five notes, where should Finale put the extra two 
notes? You indicate the order in which you want extra notes distributed among the staves by 
entering a series of staff numbers in this text box.

If, in this example, you entered 12345678 in this text box, Finale would distribute “extra” 
notes from the original five-note chord sequentially among the resultant staves. That is, it 
would notate the top two notes on the first exploded staff, the next two on the second staff, and 
the fifth (bottom) note on the third exploded staff. If the Overload Order was 11111111, how-
ever, Finale would place all the “extra” notes (the top three of the original five-note chord) on 
the top exploded staff; the remaining staves would receive one note apiece.

• OK • Cancel. Click OK (or press enter) to confirm your split setup, or Cancel to discard it, 
and return to the Track/Channel Mapping dialog box, where None will appear in the Split col-
umn for the row you clicked.

Hand Width Split dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click Set Track-to-Staff List. In the Track/Channel Mapping for Staves dialog box, click the 
first row of information you haven’t yet filled in. Click Hand Width.

What it does
This dialog box lets you transcribe the contents of the sequencer tracks you’ve specified into two 
staves, splitting the notes according to the width of your hands, based on the numbers you enter in 
this dialog box. The advantage of this method of splitting your performance into right- and left-
hand parts (as compared with the Fixed split point option) is that Finale follows your hands as 
they move up and down the keyboard, eliminating the need to specify a single, fixed split point—
provided there’s always a large enough gap between the hands for Finale to know which hand is 
which.
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• Starting Right Hand Position • Starting Left Hand Position • Listen. These text boxes let 
you tell Finale where your right and left hands are at the beginning of the track(s) to be tran-
scribed. The numbers are synthesizer key numbers (middle C is key number 60), and they 
specify the starting position of your leftmost finger of each hand.

Instead of calculating key numbers and entering them in these boxes, just click the Listen but-
ton, then play the note or chord that begins the left-hand (or right-hand) part of the track 
you’re transcribing. Finale automatically enters the key number into the appropriate text box 
(in which you’ve clicked the cursor).

• Hand Width: • Listen. In this text box, enter the widest interval, in half steps, that either hand 
played during your performance. Instead of calculating the number of half steps, click Listen 
to MIDI, and play the widest interval. The checkbox is no longer selected, and the Hand Width 
text box displays the width of the interval.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the hand width settings 
you’ve just made. You return to the Track/Channel Mapping dialog box.

Filter Channels dialog box
How to get there
Choose Open from the File Menu, and select MIDI File from the File Type drop-down list. Dou-
ble-click the name of a MIDI file you want transcribed. In the Import MIDI File Options dialog 
box, click the Set Track-to-Staff List radio button. In the Track/Channel Mapping to Staves dialog 
box, click the topmost unassigned row of track information; the Track/Channel Mapping dialog 
box appears. Enter the numbers of the tracks from which you want to select ranges of notes to be 
transcribed in the text boxes at the top of the window; click Filter.

What it does
The Track/Channel Mapping dialog box offers you a great deal of control over the way in which 
your sequencer-file tracks are transformed into Finale staves. You can tell Finale to create up to 
eight staves out of a single sequencer track, to create one Finale staff from up to four sequencer 
tracks, and so on.

You can think of the Filter split option as the inverse of the Fixed, Multiple, and other split 
options. Where these other functions serve to split the notes on the tracks you’ve specified into 
separate staves, the Filter function lets you combine selected notes from several different 
sequencer tracks onto a single Finale staff.

In the Filter Channels dialog box, you specify the ranges of the notes from each of up to four 
tracks you want Finale to transcribe onto a single staff. Note, however, that the Filter function has 
no meaning if you haven’t specified at least one track by entering its number in one of the text 
boxes at the top of the Track/Channel Mapping dialog box. If you click Filter without having 
specified a track, Finale will display an alert message.
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• Track/Channel (#):(#). There are up to four of these indicators, which identify the track and 
MIDI channel number pairs you entered at the top of the Track/Channel Mapping dialog box.

• Key Range: Low • High • Listen. In each pair of these text boxes, you enter a low and a high 
key number; in this way, you can specify up to four registers, one from each of the four track/
channel combinations identified by the Track/Channel (#):(#) indicators. Finale will transcribe 
only the notes within each of these registers onto a single staff in the resulting transcription.

Middle C is key number 60, and keys are numbered sequentially from left to right on the key-
board. (You can even enter a Low key number that’s higher than the High number; Finale will 
include in the transcription all notes except those in the register you’ve just outlined.) Note, 
however, that you don’t have to calculate the key numbers and type them in manually—you 
can play them instead.

• Listen. Click the Listen button beside each pair of text boxes, and play each note—the lowest, 
then the highest note in the range; Finale enters their key numbers in the text boxes automati-
cally.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your specifications 
of note Filter settings and return to the Track/Channel Mapping dialog box.

Export MIDI File Options dialog box
How to get there
Choose Export MIDI File Options from the MIDI Menu.

Or,

Choose Save As from the File Menu. Enter a title and select MIDI File from the File Type drop-
down list. Click OK.

Also, when you save a MIDI File from the Playback Controls, the MIDI File Options dialog box 
appears when you click OK.
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What it does
You can save any document into several formats. This file format, known as a standard MIDI file, 
enables your document to be shared with other music programs (primarily sequencers), most of 
which can read this kind of file.

In this dialog box, Finale asks you which kind of MIDI file you want to create; most sequencers 
can read any of these formats.

The MIDI File Options dialog box also lets you save bookmarks as markers when you create a 
MIDI file. 

• MIDI File Type: Format 1. Click this button (or press enter) to create a Format 1 MIDI file—
by far the most widely used format, which contains multiple tracks. In Finale, every Instru-
ment is placed in its own track; remember that each element of each staff (Layer 1–4, Chords, 
and Expressions) can have its own Instrument assignment. Remember, too, that unless you’ve 
given each of these elements its own Instrument, the resultant MIDI file won’t have multiple 
tracks. For a discussion of Instruments, see MIDI TERMINOLOGY–MIDI CHANNELS (or 
INSTRUMENT LIST WINDOW).

• MIDI File Type: Format 0. In this MIDI file format, all of the music is placed in a single 
track, separated only by MIDI channel. In Finale, however, two staves can only have different 
MIDI channel assignments if they also have different Instrument assignments. So, again, for 
the purposes of this file format, make sure you’ve assigned a different Instrument to every ele-
ment (Layer 1–4, Chords, Expressions) you want assigned to its own MIDI channel.

• MIDI File Type: Tempo Map. Certain advanced sequencer programs allow you to import a 
tempo map of a piece—that is, a separate file consisting entirely of the ritards, accelerandi, 
and other tempo fluctuations in a piece. Click this button to create a Tempo Map MIDI file 
from your document.

• Save Bookmarks as Markers. Specify whether you’d like the Finale bookmarks converted to 
sequencer marks.
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• Don’t show this during File Save As. Select this option if you wish to use the current settings 
in the Export MIDI File options next time you save a MIDI file in Finale. The Export MIDI 
File Options dialog box will not be displayed when you save a MIIDI file, only when Export 
MIDI File Options is selected from the MIDI Menu. Deselect this checkbox to again display 
the Export MIDI File Options dialog box when saving MIDI files.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to return to the score without 
creating a MIDI file.

Send MIDI Value dialog box
How to get there
Choose Send MIDI Value from the MIDI Menu.

What it does
This dialog box simply provides a convenient way to transmit any MIDI message directly to your 
MIDI device. You might send a “note off” message on all channels in the event of MIDI lock (the 
same function as the All Notes Off command–see MIDI MENU); you might use it to change the 
patch setting of one of your keyboards; or you could reset a MIDI keyboard’s sustain pedal or 
pitch wheel that’s become “stuck” in the down position, for example. The permissible range of 
values in any of the text boxes is zero to 127.

To send bank and program changes immediately, enter the program change and bank select values 
into the Send MIDI Value dialog box. Sending controller data is simple. To choose a controller, 
click Controller, then choose the name of the controller, such as 64:Sustain Pedal, from the Con-
troller drop down list.
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• All MIDI Channels • Only MIDI Channel ___. With these controls, you specify the MIDI 
channel on which you want Finale to transmit the specified MIDI data. If you select All MIDI 
Channels, Finale transmits the specified data on all sixteen MIDI channels (from both ports). 
If you select Only MIDI Channel ___, Finale only transmits the data on the MIDI channel 
whose number you enter in the text box.

• Key Off • Key On. Click one of these buttons if you want Finale to transmit a Key Off 
(“release the key”) or Key On (“play the key”) message to the key whose number you’ve 
entered in the first text box. (MIDI key numbers increase sequentially as you move to the right 
on the keyboard; middle C is key number 60.) In the second text box, enter the key velocity 
value with which you want the note struck (or released, for synthesizers that respond to key 
off velocity data).
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• Controller. Click this button and place the controller number in the first text box (or select the 
desired controller from the drop-down list). In the second text box, enter the value you want 
sent for the controller whose number you’ve entered in the first text box. For a list of MIDI 
controllers and their numbers, see the APPENDIX–MORE ON MIDI. 

• Patch. Click this button to make a Patch change. From the drop down list choose whether you 
want to make a simple program change, or a bank and program change; then use the Bank 
Select and Program Change text boxes to make the changes. Or just select the instrument you 
desire from the General MIDI drop down list and the Bank Select and Program Change will be 
set for you automatically. See PATCHES for a detailed description of how patch information 
works.

• Pitch Wheel • Channel Pressure. Click one of these buttons if you want Finale to transmit 
the pitch wheel or channel pressure (monophonic aftertouch) value you’ve specified in the text 
box.

• Other. If you’re very familiar with the MIDI protocol, you can use this button and set of text 
boxes to transmit other kinds of MIDI data—system exclusive data, for example. The first text 
box contains the highest portion of the status byte. The contents of the remaining text boxes 
depend upon that status byte. See APPENDIX for a discussion of status bytes.

• Done • Send. Click Send to transmit the data you’ve specified. Click Done to exit the dialog 
box.

MIDI Sync
MIDI Sync signals, often referred to as Song Pointer data, consist of a stream of MIDI data that 
allows two sequencers or computers to perfectly synchronize their playback or recording (provid-
ing both are equipped to interpret this data). Finale can both transmit and receive MIDI Sync data; 
in other words, you can either use Finale to drive external sequencers so that they all play back 
together, or you can record new music in Finale (or listen to a playback of a Finale score) along 
with the tempo track of a sequencer that’s sending MIDI Sync data. Finale supports MIDI clock 
signals but does not support SMPTE, MIDI Time Code, or MIDI Machine Control.

To transmit MIDI Sync data while playing back a Finale score
Finale sends MIDI Sync (Song Pointer data) when you’re playing back music in the Transcription 
window, or when you’re using the Playback Controls (and Pre-Scan Music or Play using Playback 
file is selected). In either case, Send MIDI Sync must be selected in the MIDI Setup dialog box. 
(Finale only responds to Song Pointer data when playing back a disk file—that is, a playback file; 
see PLAYBACK.)

Follow these instructions if you want Finale to be the “master” device and an external sequencer 
to be the “slave” (in other words, Finale is providing the synchronization signal).

• Choose Send MIDI Sync from the MIDI Menu.From now on, Finale will transmit MIDI 
Sync (Song Pointer data) any time it plays back your score. If you have connected your com-
puter to an external sequencer (or another computer) configured to interpret this kind of MIDI 
message, it will wait in “pause” mode until Finale begins to play, at which point the two will 
play in synchronization.
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To receive MIDI Sync data while playing back a Finale score
Follow these instructions if you want Finale to be the “slave” device and an external sequencer to 
be the “master” (in other words, the external sequencer is providing the synchronization signal). 
Finale supports MIDI clock signals but does not support SMPTE, MIDI Time Code, or MIDI 
Machine Control.

• From the Window Menu, choose Playback Controls. Playback Controls appears.

• Click the Playback Settings button. The Playback Settings dialog box appears, offering 
additional controls.

• Click Playback Options. You can also click on the Options menu, then Playback Options. 
The Playback Options dialog box appears.

• Select Wait for MIDI Sync, and then click OK. Make sure your Play Mode in the Play-
back Controls is set to Non-Scrolling (Pre-Scan Music). Finale now waits for a MIDI Sync 
signal from the external sequencer. Once the external sequencer begins to play, Finale will 
automatically “sync up” to it, playing precisely together with it, even if you jump forward or 
backward in the external sequence.

• Click Play. Finale will pre-scan the music and then wait for the MIDI Sync data from the 
other MIDI device before playing the music.

To transmit MIDI Sync data while recording in the Transcription Mode
You can transmit MIDI Sync signals during either recording or playing back in the Transcription 
Tool. You might want to set up this configuration if, for example, you want to record a new track 
with a drum machine as accompaniment. Using this technique, Finale will “drive” the drum 
machine as you record new music in the Transcription window. Finale supports MIDI clock sig-
nals but does not support SMPTE, MIDI Time Code, or MIDI Machine Control.

• Click the HyperScribe Tool g select Transcription Mode and click a measure. The 

measure you click will be the first measure of the resultant transcription. You enter the Tran-
scription window.

• Choose Click Output from the Time Tag Menu. The Click Output Type dialog box appears.

• Click Send MIDI Sync. Click OK (or press enter). 

• Enter Time Tags in the usual way. You can record Time Tags either by tapping a key or 
pedal, or by telling Finale to enter them automatically (using the Set To text box). You can find 
full instructions for the first method of entering Time Tags under TRANSCRIBING A SEQUENCE, 
and for the second method under METRONOME MARKINGS.

• Under the words Time Tag, click Play. Proceed with your playback or recording as usual. 
Finale will transmit MIDI Sync (song pointer data) instead of providing an audible click. If 
you have connected the computer to an external sequencer (or another computer) that has been 
configured to interpret this kind of MIDI message, it will wait in “pause” mode until Finale 
begins play, at which point the two will play in synchronization.

To use the MIDI Sync signal to provide the “tap” in HyperScribe
Normally, when you’re transcribing music in HyperScribe, you tap a key or pedal to provide 
Finale with a tempo reference. If you’re using HyperScribe to transcribe music being played by an 
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external sequencer, however, the sequencer can provide the tempo reference by itself by transmit-
ting MIDI Sync signals. Finale supports MIDI clock signals but does not support SMPTE, MIDI 
Time Code, or MIDI Machine Control.

• Click the HyperScribe Tool g. The HyperScribe Menu appears.

• From the Beat Source submenu of the HyperScribe Menu, choose External MIDI Sync. 
Proceed with the usual HyperScribe preparations, concluding by clicking the first measure in 
which you want the transcription to appear. Finale will wait in pause mode until it receives the 
MIDI Sync signal, at which point it will automatically “sync up” to it, transcribing the music 
as it goes. No tapping is needed.

To transmit Song Pointer data during playback
• Choose MIDI Setup from the MIDI Menu. The MIDI Setup dialog box appears.

• Select Send MIDI Sync. Click OK (or press enter). You may also choose Click Output from 
the Time Tag Menu, and select Send MIDI Sync; Finale will now transmit this information 
instead of an audible click.

MicNotator dialog box
How to get there
From the MIDI Menu, choose MicNotator. If the MicNotator is unavailable in the menu, make 
sure the 32-bit MIDI driver is selected.

What it does
This dialog box allows you to set up options for the MicNotator feature. With MicNotator, Finale 
converts the pitch you play in a microphone into a MIDI note when you use Speedy Entry or 
HyperScribe. Check the Enable box to use the MicNotator feature in Speedy Entry and Hyper-
Scribe. You should use the levels meter to fine-tune your microphone input. For more details, see 
MICNOTATOR.
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• Enable MicNotator. Check this box to use the MicNotator feature to convert pitches recorded 
through the microphone to MIDI notes that Finale can transcribe into notation in Speedy 
Entry or HyperScribe.

• Levels: Mic Level • Input Meter. When you play into the microphone, you’ll see colored 
bars in the Input Meter, indicating how loud Finale heard you. Adjust the Mic Level slider to 
change your microphone input levels so that your loudest note doesn’t hit the red levels. If the 
levels are too “hot,” the distortion will impair MicNotator’s pitch recognition.

• Recording Options: Channel. Specify your input channel.

• Mic Options: Mic Source • Mic Thru Speaker. Select an input source from drop-down list. 
Check the Mic Thru box to have the microphone play through your speaker. 

• Microsoft® Volume Controls: Output • Input. These button open the Volume Controls of 
your Windows operating system.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your MicNotator set-
tings and return to the score.
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MIDI files
Finale both imports and exports standard MIDI files. A MIDI file has a format that can be under-
stood by music programs from different companies, including most sequencer programs—even 
on other brands of computer. If you prefer to compose by improvising in your favorite sequencer, 
you could save your piece as a standard MIDI file and let Finale notate it for you.

When you save a MIDI file, Finale saves the instrument name (from the Instrument List) as the 
track name. When you open a MIDI file, Finale uses the track name as the staff name (which 
appears in the Staff Attributes dialog box).

To import a MIDI file
To create the MIDI file, follow your sequencer’s instructions. There’s no need to quantize the 
sequence; however, you’ll probably find Finale’s quantization powers to be more effective than 
your sequencer’s.

• Choose Open from the File Menu. The Open dialog box appears. The file types are listed in 
the drop-down list at the bottom of the window.

• Click MIDI File. The names of any available MIDI files appear in the list box.

• Double-click the desired document name. The Import MIDI File Options dialog box 
appears, listing various transcription options.

• Specify the way in which you want the MIDI file extracted onto Finale staves. If you click 
Tracks Become Staves, each sequencer track becomes a Finale staff. If you click Channels 
Become Staves, the contents of each MIDI channel (regardless of their track assignments) 
become a Finale staff. In either case, Finale will choose a clef for each resultant staff based on 
the range of notes in the track. (If it discovers that the notes in a track have a very wide range, 
it will automatically notate its contents on two staves. See IMPORT MIDI FILE OPTIONS DIA-

LOG BOX for details.) For even greater control over the track and channel extraction, click Set 
Track-to-Staff List; the Track/Channel Mapping to Staves dialog box appears, in which you 
can specify extremely sophisticated track and channel splitting.

• Click Quant Settings. The Quantization Settings dialog box appears.

• Click the icon representing your smallest note value. 

• Choose your quantization type. See QUANTIZATION SETTINGS DIALOG BOX for more details.

• Click More Settings. The More Quantization Settings dialog box appears.

• Select the quantization settings you desire. You can select options for grace notes and voice 
2, as well as retain key velocities and note durations.  See MORE QUANTIZATION SETTINGS 
DIALOG BOX for details.

• Choose Key and Time Signature options. Most MIDI files contain key and time signature 
information already, so you usually won’t have to change the default selection (Use the File’s).

• If you’ll want to hear the sequence played back with its original tempo fluctuations and 
continuous data (controllers and wheels) data, make sure Tempo Changes and Continu-
ous Data are selected. These options capture some of the MIDI performance data from your 
sequence. For a more complete description of performance data, see Installation & Tutorials. 



MIDI files 8-31      

OC

OC

ndex

Index

ext 
hapter

revious
hapter

ext 
hapter

revious
hapter
T

T

I

N
C

P
C

N
C

P
C

• Click OK (or press enter). Finale transcribes the MIDI File into standard notation. If you dis-
cover that your settings weren’t quite right, you can close the new Finale document and try 
again—the original MIDI file is unaffected by Finale’s transcription efforts. Or, for smaller 
sectional changes, use the Retranscribe function in the Mass Mover tool. For more informa-
tion about the elements of the Import MIDI File Options dialog box, see IMPORT MIDI FILE 
OPTIONS DIALOG BOX and RETRANSCRIPTION.

To export a MIDI file of the entire document
• Prepare your Finale file. Keep in mind that any playback data will be retained in the MIDI 

file. This includes tempo changes (for those sequencers that support a tempo, or conductor, 
track), dynamics, pitch wheel data, MIDI channel assignments, and so on. Be sure to specify 
other important playback options in the Playback Options dialog box (choose Playback Con-
trols from the Window Menu; click the expand arrow; click Playback Options). Remember 
that you are exporting a MIDI file, text and layout will not be retained in this format.

• Make sure that you have assigned Instruments correctly (one for each resultant 
sequencer track). When Finale creates a MIDI sequencer file, it places the music you’ve 
assigned to each Instrument in the Instrument List dialog box in a separate sequencer track. 
Therefore, make sure the Instrument configuration is set up the same way you want the result-
ant tracks set up. See MIDI TERMINOLOGY–MIDI CHANNELS for further instructions.

• Choose Save As from the File Menu. The Save As dialog box appears.

• From the List Files of Type: drop down list choose MIDI File, and enter a title in the text 
box. Note, too, that you don’t have to click anything if you add the suffix “.MID” (including 
the period) at the end of the title, as in “Overture.MID”; if you do this, Finale automatically 
saves your document as a MIDI file.

• Click Save (or press enter). Finale now asks which type of MIDI file you want to create: For-
mat 1 (multiple tracks), Format 0 (a single, multichannel track), or just a tempo map. Format 1 
is by far the most common format. Also, choose whether you want to save any bookmarks you 
created in Finale as sequencer marks in your MIDI file.

• Select a MIDI file format by clicking the appropriate button. 

To export a MIDI file of a selected portion of your document
• Prepare your Finale file. Keep in mind that any playback data will be retained in the MIDI 

file. This includes tempo changes (for those sequencers that support a tempo, or conductor, 
track), dynamics, pitch wheel data, MIDI channel assignments, and so on.

• Choose Playback Controls from the Window Menu. The Playback Controls appear.

• Click the expand arrow. The Playback Controls expand. You may want to take a moment to 
click Playback Options and specify which MIDI playback parameters you want to include 
(such as Key Velocity or MIDI Controller information).

• Specify the measures you want included in the MIDI file. Use the Play From and Play 
Through controls.

• Click Save File. The Save As dialog box appears.

• Click MIDI File, specify the format (Type 1 is the most common), give your file a title, 
and click Save. Consult your sequencer’s manual for information on importing a standard 
MIDI File.
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MicNotator
For best results with MicNotator, follow these basic guidelines:

The purpose of MicNotator is to allow users to input notes via a wind instrument instead of a 
MIDI keyboard. This version of MicNotator is not designed for use with a vocalist (i.e., does not 
accommodate wide vibrato, glissandi, etc.). When using MicNotator, keep in mind that the 
desired result is to notate and print the music as you want it, not to record your performance. So 
think of it more like a typewriter and less like a tape recorder. NOTE: MicNotator does not sup-
port Windows NT 4.0 or earlier.

Setting up MicNotator
• Plug the microphone into your computer. Make sure it is plugged into the Mic In port, 

not Line In. 

• From the MIDI Menu, choose MicNotator. Or, click the MicNotator icon on the MIDI 
Menu Toolbar. The MicNotator Dialog box appears. If MicNotator is unavailable in the 
menu, make sure 32-bit MIDI driver is selected in the MIDI Menu. MicNotator requires the 
32-bit MIDI driver.

• Place a checkmark on Enable MicNotator.

• Under Mic Level, use the slider to control the microphone input level. THE MIC LEVEL 
IS VERY IMPORTANT TO SUCCESSFUL NOTE ENTRY WITH MIC NOTATOR. For best 
results, use the small clip-on Finale microphone available from Coda Customer Service at 
1.800.843.2066.To set the mic level, follow these steps:

• Place the microphone as follows: 

• Play your instrument and watch the level lights.

• Move the slider next to the level light up or down to obtain the correct input level. The 
lights should be green most of the time; red is too high, blue is too low. Occasional red read-
ings are acceptable. To ensure accurate pitch detection, follow the guidelines for mic place-
ment and mic level above.

Instrument Placement

Flute, Piccolo left side of shirt collar

Bassoon, Oboe, English Horn shirt above the stomach

Clarinet, Soprano Sax shirt above the stomach

Alto and Bass Clarinet music stand

Alto, Tenor and Baritone Sax neck strap

All brass outside of bell
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Using MicNotator with Speedy Entry

Before you begin, make sure you’ve set up the MicNotator for your instrument. See SETTING UP 
MICNOTATOR. You’ll need to use the Hands-Free MIDI method (unless you can play one-
handed). For more details, see SPEEDY ENTRY.

• Click the Speedy Entry Tool a, and click a measure. The editing frame appears.

• Press caps lock; then press the number key on the computer keyboard corresponding to 
the value you want to enter. In other words, you’re now telling Finale what the note values 
are going to be before you specify the pitches.

The number you press appears in the lower-left corner of the editing frame.

• Play the notes on your instrument. Each note you play appears in the score; if Jump to Next 
Measure is checked in the Speedy Menu, the editing frame advances automatically as soon as 
you fill each measure. It’s safe to outplay Finale, too; it will remember up to 500 notes (and 
continue to notate them as fast as your computer allows).

Using MicNotator with HyperScribe
Before you begin, make sure you’ve set up the MicNotator for your instrument. See SETTING UP 
MICNOTATOR. For more details about HyperScribe, see RECORDING WITH HYPERSCRIBE.

MicNotator will notate what you play, so your performance should reflect the desired printed 
results, rather than the desired sound. For instance, if you play eighth notes in a staccato style, 
they may come out as sixteenth notes rather than eighth notes. So you should play the full dura-
tion of all notes. Also, you will experience better results if you input notes at a slow tempo.

Follow the basic guidelines for quantization that you would use with MIDI input. As a general 
rule, you should quantize to the smallest duration that you will play (i.e., if your smallest duration 
is an eighth, quantize to the eighth note rather than the sixteenth). The No Tuplets quantization 
setting produces the best results. Even if you have triplets in your performance, you will have bet-
ter results using the No Tuplets setting and then editing the triplet measures (using the speedy note 
tool).

If you encounter small rhythmic errors when entering sixteenth note passages, click on the More 
Settings in the Quantization Settings dialog box and change the Very Short Notes value from 20 
EDUs to 0 EDUs.

• From the Options Menu, choose Quantization Settings. The Quantization Settings dialog 
box appears.

• Click on the More Settings button. The More Quantization Settings dialog box appears.
• Under Very Short Notes, click in the Remove Notes Smaller text box and enter 0 (zero).
• Click OK. You return to the Quantization Settings dialog box. Adjust the settings, then click 

OK. See QUANTIZATION SETTINGS DIALOG BOX for more information.

• Click the HyperScribe Tool g. The HyperScribe Menu appears.

• From the HyperScribe Menu, choose Beat Source, then Playback and/or Click. The Play-
back and/or Click dialog box appears. (See PLAYBACK AND/OR CLICK DIALOG BOX) If you’d 
rather provide the tap or tempo yourself, see TAP SOURCE DIALOG BOX.
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• Click the note duration you would like to use for your beat. Type in the number of EDUs 
for any duration that is not available from the palette.

• If you know what tempo you want to record at, enter the tempo into the Tempo text box. 
If you prefer to have Finale calculate the tempo for you, click Listen, then tap your mouse in 
the dialog box at the desired tempo. Finale will enter the tempo you play.

• Choose a start signal from the Start Signal for Recording drop-down list. Finale will 
delay starting the countoff measures and recording until it receives a start signal. Choose None 
(Record Immediately) if you don’t want to use a signal to start recording—Finale will imme-
diately start recording (after playing the countoff if one was specified); choose Any MIDI 
Data for Finale to start recording upon receiving any MIDI signal that’s played; choose Cur-
rent Metronome Sound to use the same MIDI signal as the metronome click; choose Standard 
Sustain Pedal or Nonstandard Sustain Pedal to signal the start by depressing the foot pedal; 
choose Other to define an alternate MIDI signal as the start signal in the MIDI Event dialog 
box (see MIDI EVENT DIALOG BOX).

• Deselect Play Staves While Recording or make sure MicNotator is set to a unique input 
channel. See MICNOTATOR DIALOG BOX.

• Click on Click and Countoff to set up your click and countoff options. For details, see 
PLAYBACK – CLICK AND COUNTOFF.

• Click OK. You return to the score.

• From the HyperScribe Menu, choose Record into One Staff. MicNotator only supports 
single pitch instruments.

• To start recording, click the measure in which you want Finale to begin recording. Signal 
Finale to start (if you selected a start signal). Click a measure. Or, choose Playback Con-
trols from the Window Menu, if it isn’t already selected. Change the measure if necessary, 
then click Record in the Playback Controls.

Note: If you click a measure to start recording, Finale will start recording into the measure you 
clicked, not the measure displayed in the Playback Controls.

• When you’re finished, if you are providing the beat, give one extra tap. The extra tap is 
required to fill out the beat, for the benefit of Finale’s quantization feature.

• Click anywhere on the screen to stop recording. If the quantization or split point settings 
weren’t quite right, change them; then click the first measure and try the performance again. 
HyperScribe will overwrite whatever music is already on the staff.
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